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1 Introduction 
• In this lab you will go through an entire ASIC design flow, from HDL code to 

tape-out. The lab is a tutorial for the two main tools used in the course, 
Synopsys Design Compiler and Cadence Encounter. These tools are somewhat 
complex and the purpose is not to get full understanding of the tools, but 
rather to get familiar with them. The ASIC design flow used is a simplified 
flow and it will not produce an error free chip, but it will give you the big 
picture of what it is all about. Since the focus is on the tools, the HDL code 
used in the design entry step is given. 

2 Setting up the Environment 
Before using any of the tools, remember to: 

source /digcad/smd154/2006/tools_init 
 

The files needed for the lab can be found at /digcad/smd154/2006/lab1/lab1.zip. 
The zip-file contains the following directories and files: 
 
Directory Files Description 
syn alu.v 

opcodes.v 
Given source code for lab1. 

 .synopsys_dc.setup Synopsys setup file. 
   
   
par top.conf Design configuration file for Encounter. 
 corners.io Contains information about the placement of the 

IO pads. 
 fillcore.tcl TCL script that places core filler cells. 
 fillperi.tcl -“- to add periphery filler cells 
 global_net_connections.tcl -“- to set up ground/power nets 
   
   
Par/VERILOG  Directory to store netlist from synthesis(empty) 
   

Table 1: Contents of lab1.zip 

 
Documentation for Synopsys can be found by invoking:  
 

> sold  
 
or at: /digcad/synopsys/doc/X-2005.12/doc/online/top.pdf.  
 
and documentation for Cadence can be found by invoking: 

 
> cdsdoc 

 
(select soc4.1 as active directory) 
or  at /digcad/cds_europractice/soc_4.1_sun/doc/encounter/  
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3 Design Entry 
• The design in this tutorial is a 16-bit ALU. The ALU has an on-chip 256*16 

bit memory for store and load operations. 
 

DATA 16 ALUOUT16

OPCODE

11

RESET

CLOCK

 
Figure 1: The ALU. 

 
• The memory block is instantiated by using two instances of a 128*8 memory, 

previously generated by a RAM compiler.  
•  
• You will: 
• Read in the Verilog HDL description of the ALU design (top.vhd and alu.v) 

into Synopsys Design Compiler.  
• Set up some constraints and synthesize the design.  
• Save the design as top_synth.v, which you will read into Cadence Encounter 

later on.  
 

• You will run the tutorial on the AMS 0.35 µm CMOS process. 
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4 Synthesis flow 
Design Compiler is the core of the Synopsys synthesis software products. It comprises 
tools that synthesize your HDL designs into optimised technology-dependent, gate-
level designs. It supports a wide range of flat and hierarchical design styles and can 
optimise both combinational and sequential designs for speed, area, and power. Figure 
2 shows a simplified overview of the Design Compiler synthesis process. 
 

Synopsys Design 
Compiler

VERILOG source

VHDL source

Other formats

Mapped, Technology- 
Dependent Netlist

 
Figure 2: Design Compiler Overview. 

 
• Synopsys Design Compiler provides 2 modes, XG mode (latest default mode 

increasing tool capacity) and (old) DB mode. Design Compiler offers two 
interfaces, command line interface (shell) or GUI. 

 
You can interact with the Design Compiler shell by using the following command 
languages: 

• dctcl. This Design Compiler command language is based on the Tool 
Command Language (Tcl) and includes certain command extensions needed 
to implement specific Design Compiler functionality. This shell mode is 
referred to as the Tcl mode. 
 

• dcsh. This is the original Design Compiler command language and is specific 
to Synopsys. This shell mode is referred to as the dcsh mode and is available 
only in DB mode. XG mode does not support this language. 
 

Design Vision is the graphical user interface, with menus, dialog boxes, and so forth 
to implement Design Compiler commands to the Synopsys synthesis environment. It 
also provides graphical displays, such as design schematics and can be used for 
visualizing design data and analysis results.  

•  
• The command line  interface provide capabilities similar to UNIX command 

shells, including such capabilities as variable assignments, conditional 
execution of commands, and control flow commands. However, in this 
tutorial, we use the Design Compiler GUI. 

 
• Design Compiler reads and writes design files in all the standard electronic 

design automation (EDA) formats, including Synopsys internal database (.db 
and .ddc) and equation (.eqn) formats.  

•  



SMD154 VLSI Design  Lab 1: Quick Tool-Tutorial 

 6(21) 

• Figure 3 shows the basic synthesis flow. Also listed are the basic commands, 
commonly used in each step of the basic flow. For example, the commands 
analyze, elaborate, and read_file are used in the step that reads design 
files into memory. All the commands shown can take options, but no options 
are shown in the figure. (Note. The first step can be seen as the design entry to 
the synthesis process. You do not develop your HDL files with the Design 
Compiler tools). 
 

Develop HDL Files

Specify Libraries

Read Design

Define Design 
Environment

Set Design 
Constraints

Select Compile 
Strategy

Library Objects 
l i nk_l i br ar y  
t ar get _l i br ar y 
symbol _l i br ar y 
synt het i c_l i br ar y

anal yze 
el bor at e 
r ead_f i l e

set _oper at i ng_condi t i ons 
set _wi r e_l oad_model  
set _dr i ve 
set _dr i v i ng_cel l  
set _l oad 
set _f anout _l oad 
set _mi n_l i br ar y  

Design Rule Constraints 
set _max_t r ansi t i on 
set _max_f anout  
set _max_capaci t ance  

Design Optimization Constraints 
cr eat e_cl ock 
set _cl ock_l at ency 
set _pr opagat ed_cl ock 
set _cl ock_uncer t ai nt y  
set _cl ock_t r ans i t i on 
set _i nput _del ay 
set _out put _del ay 
set _max_ar ea 

Optimize the Design

Analyze and Resolve 
Design Problems

Save the Design 
Database

Top Down 
Bot t om Up

compi l e

check_desi gn 
r epor t _ar ea 
r epor t _const r ai nt s  
r epor t _t i mi ng

 
Figure 3: Basic synthesis flow with commands commonly used in each step of the flow. 



SMD154 VLSI Design  Lab 1: Quick Tool-Tutorial 

 7(21) 

4.1 Specify libraries. 
Start Design Compiler GUI by following these steps: 

• Change directory to: lab1/syn 
• Run the program by enter: design_vision 

 
When the program starts, initialization of variables, library objects etc. have been 
setup via the Synopsys init file, .synopsys_dc.setup in the Synopsys root 
directory, your home directory and in the current working directory, 
 
Example from the .synopsys_dc.setup (in your working directory). 
 
 
AMS_DIR     = get_unix_variable(AMS_DIR) 
SYNOPSYS     = get_unix_variable(SYNOPSYS); 
search_path    = {"." \ 
  AMS_DIR + "/synopsys/c35_3.3V"  \ 
  SYNOPSYS + "/libraries/syn"    \ 
  SYNOPSYS + "/dw/sim_ver"} 
 
search_path    =   search_path + { ../memory } 
 
symbol_library = {c35_CORELIB.sdb c35_IOLIB_4M.sdb} 
target_library = {c35_CORELIB.db c35_IOLIB_4M.db c35_IOLIBV5_4M.db}; 
target_library = { sram128x8.db } + target_library 
 
link_library   = "*" +  target_library + synthetic_library; 
link_library   = { sram128x8.db } + link_library 
 
The link and target libraries are the technology libraries that define the vendor’s set of 
cells (cell pin names, design rules etc.). Design Analyzer uses the symbol library to 
show the schematics of the design. The c35xxxx.db are the core and I/O cells for the 
AMS 0.35µm process. The sram128x8.db is the memory block. 
 
Synopsys generates a lot of information. All executed commands and system response 
messages are recorded in the file command.log. The filename_log_file will 
contain all the filenames read in by Design Compiler, including db, script, verilog, 
and vhdl or include files for one invocation of the program. 

4.2 Getting help 
There is an on-line help menu button in the upper right corner of the Design Vision 
GUI window. You can use select Help->Man Pages to look up information about 
commands.  

4.3 Read design. 
You can use the analyze and elaborate commands to read the RTL-design.  
 

• The analyze command reads the HDL-file and checks it for errors. Create and 
stores the file(s) into an intermediate format.  
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• The elaborate command creates a technology independent design from the 
intermediate files.  
 

• The read_file command reads all input formats. (Precompiled designs…) 
(If the read_file command is used to read RTL-files, the analyze- and 
elaborate functions are combined.) 

 

To read in the source file, select: 

  File->Read… 

and select first the file alu.v. , then read the file top.vhd. In the Log window, the 
result of the command e.g. inferred memory devices (flip-flops, latches), errors and/or 
warnings will be shown.  
 
Select ALU from the Logical Hierarchy (as show in figure below), then click on 
Create Design Schematic (the  symbol). When you zoom in the window to a cell, 
e.g. as the GTECH_OR4 as in the figure, the symbol represents cells that are not yet 
mapped to gates. 
 

 
Figure 4 bl 

Note. Design Compiler does not automatically save the designs loaded in memory. If 
you want to save these designs before exiting, you have to save the design to disk. 

4.4 Define design environment & Set design constraints 
After you read in the design into Design Compiler, you specify the design 
environment. Design Compiler requires that you model the environment of the design 
to be synthesized. This model comprises the external operating conditions 
(manufacturing process, temperature, and voltage), loads, drives, fanouts, and wire 
load models. You model the environment in which the design is expected to operate 
by setting attributes. See Figure 5 for commands used to define the design 
environment. 
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The design constraints define the design goals for timing (clocks, clock skews, input 
delays, and output delays) and area.  
 

 
Figure 5: Commands used to define the design environment. 

4.4.1 Setting output load. 
Load values are used to model the capacitive load on the output ports of the module. 
Create a Symbol for the TOP (select TOP in the Logical Hierarchy, then click Create 
Symbol view) design. 
Then select the output bus (ALUOUT), and select 
 

Attributes->Operating Environment->Load… 

To set the output load to 0.1 pF, enter 0.1 in the Capacitive Load field, then OK 

4.4.2 To set the operating conditions 
To set the operating conditions for the TOP design, select:  

Attributes -> Operating Environment ->Operating Conditions… 

In the operating conditions from, select:  

Library:  C35_CORELIB 
Condition:  TYPICAL 

 
The operating conditions will be set to nominal conditions. (You can use the 
report_lib c35_CORELIB command at the shell prompt to list the operating 
conditions defined in a technology library).  

4.4.3  Set the wire load model 
Wire load models estimates the effect of wire length and fanout on the resistance, 
capacitance and areas of nets.  
To set the wire load model of the TOP design, select:  

Attributes -> Operating Environment ->Wire Load… 

In the Wire Load form, select:   

10k (c35_CORELIB) 
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4.4.4 Specifying a clock 
Select the CLOCK pin of the TOP design, and then select: 

  Attributes -> Specify Clock…  

In the form, enter 50 in the Period field, 0 in the Rising field and 25 in the Falling 
field.  Click then OK. This will set the clock period to 50 ns. 

4.5 Optimize the design 
You use  

Design-> Compile Design …  

to invoke Design Compiler’s synthesis and optimization process. Set the Ungroup all 
setting for Compile Options, then hit OK. In the start of the Compile Log, Synopsys 
prints out information about DesignWare libraries, which are reusable components 
integrated to the Synopsys environment. The rest of the log shows the progress of the 
synthesis process.  
You can ignore any warnings for now. If you take a look at the schematic of the 
design, the symbols should indicate that the design has been mapped to a target-
depended (AMS 0.35 µm) library. 

4.6 Analyze and resolve design problems 

4.6.1 To generate and view reports  
A number of reports can now be generated. To generate and view reports of the TOP 
(alu) design, select the TOP in the logical hierarchy view, then choose:  
 

Timing -> Report timing… 

Don’t change the default settings, Click OK. The worst slack timing report for the 
design appears in a new report view and the console log view.  
View the report output. The worst slack timing report begins by showing the default 
options, operating conditions, technology library, wire load model mode, and 
startpoint and endpoint of the worst timing path in the design. The path group and 
type are displayed. This information is followed by a table of incremental timing 
contributions from each of the cells in the path and the cumulative timing or data 
arrival time. The design should not have any violating constraints and the path with 
the max delay should have a (positive) slack of approximately 21 ns. 
 

4.7 Writing SDC file 
To write out a script in Synopsys Design constraints format (SDC) to a file that can be 
used later for the place and route tools (in our case Encounter), enter  
 

write_sdc -nosplit alu.sdc 

on the command line. The generated file includes the design constraints we have 
applied for our design for synthesis.  
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4.8 Writing SDF file 
To write timing data that can be used for post-synthesis simulation (a Standard Delay 
Format file), choose 
 File -> Save Info -> Design Timing… 
Save the timing file in the top.  

The information: 
design_vision-xg-t> write_sdf -version 2.1 top.sdf 

Information: Annotated 'cell' delays are assumed to include load 

delay. (UID-282) 

Says that the (estimated) interconnect delay actually is part of (or included in) the cell 
delays (If you look in the top.sdf file you will find that the interconnect delay is set to 
0). 

4.9 Save the design database 
To create a Verilog HDL gate-level netlist (top_synth.v), select:  

File -> Save As…  

In the Save File form, enter top_synth.v for filename and Verilog for format. The 
design can now be imported by the physical design step. 
  
You are now done with the synthesis part of lab1 and can exit Design Vision and 
continue with Place & Route. 

4.10 Scripts 
In reality, you use scripts to synthesize the design. Have a look at the command.log 

file to see the tcl-syntax of the commands that you have used so far. 

 
To run a script in dcsh mode, you could use, assuming the script to be in the script 
directory: 

$/syn>dc_shell -f ./scripts/xxx.scr > some_file.log  



SMD154 VLSI Design  Lab 1: Quick Tool-Tutorial 

 12(21) 

5 Place & Route 
 
Cadence Encounter provides an integrated solution for an RTL-to-GDSII design flow. 
Before starting Encounter, copy the files top_synth.v and top.sdc from synthesis into 
the lab1/par/VERILOG firectory.  
Start the encounter GUI by following these steps: 
 

• Change directory to: lab1/par 
• Run the program by enter: encounter -overwrite       

 
The current working directory will contain a log file of the session, and a command 
file similar to Synopsys Design Compiler including the commands entered during the 
session. If not using the –overwrite switch, a new session log and command log is 
created for every new session started. 

5.1 Importing Design Files. 
To start importing files to Encounter, select 
 

Design  -> Design Import… 
 

The Design Import form is used to load the Verilog netlist, physical libraries, process 
technology libraries, timing libraries, and timing constraints. A LEF file contains 
information about the library being used and is normally provided by the foundry for 
the technology you are using (i.e. AMS). We also import Timing Library Format 
(TLF) files which are used e.g. in both setup and hold timing analysis. We also 
specify the synthesised netlist from Design Compiler. In this tutorial, the Design 
Import configuration is given. Select the Load… button and select top.conf file to fill 
in the fields in the Design import form. 
When loaded, the form should look like the figure below. 
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Figure 6 Design Import 

Finally, click on OK button and the configuration is loaded. 
 
You will probably get errors like: 
 
**ERROR: Macro 'DFSECP1' obs coordinate  x value 2.996 isn't on 
manufacturing grid. It's likely result in placement/routing that can't be 
manufactured   
 
which can be ignored. 
 

5.2 Floorplanning and Power Planning 

5.2.1 Floorplanning 
Floorplanning is used to predict and assess the effects of physical layout before a 
design is placed and routed, thus speeding up the design process. 

5.2.2 Initialising a Floorplan 
A number of variables are set and an initial floorplan is created. The variables will 
have a significant impact on the final die size. The most significant factor is the row 
utilisation number that could be between 70% and 90% for a three-layer design, and 
90% or more for a five-layer design. The utilization of the core rows is depending 
very much on the design. The given values are typical ones, but cannot be seen as 
fixed. Some designs allow higher utilizations; some need lower utilization to be 
routable. Also additional cells for a clock tree have to be taken into account. 
Select  
 

Floorplan -> Specify Floorplan 
 
Use the default setting for Core Size by: Aspect Ratio. The default core 
utilization is as low as 35% (the design is small, with “many” io pads), which means 
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that 65% of the core area will be free for possible future buffer insertions or cell 
replacements. (Take the opportunity to test different settings of the utilization to get a 
feeling for how the values affect the final area). 
Under the section of Core Margins by: Core to IO Boundary, enter: 

Core to Left: 100 
Core to Right: 100 
Core to Top: 100 
Core to Bottom: 100 

When done the Specify Floorplan should look something like the figure below. 
 

 
Figure 7 Specify Floorplan 

 
Finally, Click OK to initialise the floorplan. 

5.2.3 Placement of CAP cells 

Before placing the standard cells the CAP cells have to be put to the ends of the rows. 
Select: 

Place -> Filler -> Add End Cap...  

and enter  

• Pre Cap Cell: ENDCAPL 
• Post Cap Cell: ENDCAPR 
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• Prefix: ENDCAP  

and click OK. ENDCAPL cells will be placed on the left end of the rows. ENDCAPR 
cells on the right side.  

5.2.4 Placing Blocks 
If the design contains blocks they should be placed before the standard cells are 
placed. The blocks can be placed either automatically or by manually moving them 
into position. In this tutorial the automatic method is used. Use the Place Blocks form 
to place modules or blocks, and hard macros at the top-level of the design. Choose  
 
 Floorplan -> Place Blocks/Modules -> Place… 

 
Keep the default values, (this will set a distance of 30µm around blocks for power and 
signal routing), then Click OK.  
You can use the View Placement Solutions form to view multiple placement solutions 
(default value was set to 3) by choosing 
 

 Floorplan -> Place Blocks/Modules -> View Placement Solutions 
 
When satisfied, double-click on each of the blocks and set the status to FIXED. 
To add placement blockage around the two memory blocks, select the two blocks 
(clicking and holding down the shift-key). Then select  
 

Floorplan->Edit Block Halo… 
 
Enter 20 um in all sections and also select From Instance Block option. The halo 
prevents the placer from placing standard cells into the halo area (the area we just 
specified). 

5.2.5 Saving the Floorplan Database 
The floorplan database now contains completed floorplanning but no power planning, 
and now could be a nice place to save the design. Select 
 

Design-> Save Design… 
 
and Enter design name top_fplan.enc 
 

5.2.6 Power Planning 

5.2.7 Global net Connections 
Before designing any power and ground rings or stripes, we must assign the global 
nets of power and ground. The Global Net Connections form (Floorplan-> Global Net 
Connections…) assigns pins or nets to a global net such as a power or ground. 
However, in this tutorial a script is provided, hence execute the script on the 
command line by: 
 

> source global_net_connections.tcl 
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The script contains: 
 
globalNetConnect vdd! -type pgpin -pin vdd! -inst * -module {} 
globalNetConnect gnd! -type pgpin -pin gnd! -inst * -module {} 
globalNetConnect vdd3o! -type pgpin -pin vdd3o! -inst * -module {} 
globalNetConnect vdd3r1! -type pgpin -pin vdd3r1! -inst * -module {}  
globalNetConnect vdd3r2! -type pgpin -pin vdd3r2! -inst * -module {}  
globalNetConnect gnd3o! -type pgpin -pin gnd3o! -inst * -module {} 
globalNetConnect gnd3r! -type pgpin -pin gnd3r! -inst * -module {} 
globalNetConnect vdd! -type pgpin -pin A -inst VDD_ALL -module {} 
globalNetConnect gnd! -type pgpin -pin A -inst GND_ALL -module {} 
 
The vdd3r1! vdd3r2! vdd3o! and gnd3r! gnd3o! are peripheral ring nets (and are not 
used if you are just routing a digital standard cell block without periphery cells). The 
–pin A is for the power and ground pads. 
 

5.2.8 Add rings 
Now we are ready to create power and ground rings around the core area and around 
the memory blocks. Power and ground ring are added the core area and blocks by 
using the: 

Flooplan -> Power Planning -> Add Rings… 
 
Enter in the Add Rings form (using the same Add Rings form. We can only specify 
one type at a time. Since we need both core rings and block rings, we create core rings 
first, then select this form again to create block rings) the following: 
 

 
Figure 8 Rings for the core 

 
Figure 9 Rings for the blocks 

 
The ring configuration defines ring widths of 4 micron spaced by 1.0 micron. The 
core rings will be placed in the center of the channel between the core and the IO 
pads. The memory block rings follow the contour of each block. 
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5.2.9 Adding Stripes 
To add stripes do the following. Select: 
 

Flooplan->Power Planning -> Add Stripes… 
 

Enter the following: 
 

 
Figure 10 Adding stripes form 

 
Click the OK button. The vertical power and ground stripes are then created and 
connected. Each stripe will be 2 micron wide and the space between them will be 1 
micron.  
 

5.2.10 Saving the Powerplan Database 
The floorplan database now contains completed floorplanning and power planning. 
Save the design if you want to. 

5.3 Placement 

5.3.1 Placing Standard Cells in a non-timing critical design 
At this point the floorplan contains rows for all the standard cells. The next step is to 
place the standard cells from the synthesized netlist in the rows. Select 
 

Place -> Place… 
 

Use the default options, as indicated in the figure below, and click OK.  
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Figure 11: The Place Cells form. 

5.4 Clock Tree Generation (CTS) 
To create a clock tree, we first use the Create Clock Tree Spec form to create a clock 
tree specification file. (The clock tree specification file defines the clocks in the 
design that you want to synthesize.) Select: 
 

Clock -> Create Clock Tree Specs… 
 
Fill in the form according to the figure: 

 
Figure 12 Clock tree spec. 

 
Enter BUF2 and INV0 in the footprint section of the form, The entries specifies the 
name of the buffer's and inverter’s footprint from the timing library. 
Click OK to generate the file. Open and look at the generated file (top.ctstch). It is 
possible to alter the values for the clock tree, for example the default value for clock 
skew is set to 300 ps. For now, we use the default values. 

5.4.1 Running CTS 
The first step is to load the file previously created. Select: 

 
Clock -> Specify Clock Tree… 

 
And select the file previously created (top.ctstch). 
 
Then select: 

Clock -> Synthesize Clock Tree… 
 
And fill in the form according to the figure. 
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Figure 13 Synthezise Clock Tree 

 
 
 
Then click OK to generate the tree. When the run is finished, a timing analysis is 
reported to the console output. (A more detailed report can be found in the 
top_cts.ctsrpt in the top_cts directory. In addition, the new netlist, top_cts.v also 
contains the standard cells added for the clock tree). 

5.5 Routing 

5.5.1 Filler Cells 
The AMS 0.35µm process requires that the space between the periphery cells has to 
be filled with special cells that will also connect the power supply lines. In addition, 
core filler cells must be placed between the core cells to avoid design rule violations. 
This is done before the routing is started. There is no menu command that can be used 
to fill the gaps between the periphery cells. Execute the scripts by: 

 
>source fillperi.tcl 

 
and 
 

>source fillcore.tcl 

5.5.2 Special Routing 
The first step during the special routing is to connect the stripes and blocks to the 
power rings in the design. Select 
 

Route -> SRoute … 
 
Fill out the form according to the figure below. 
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Figure 14: The Connect Ring form. 

Click OK 
This will connect the power and ground rings around the core to the power and 
ground pads, memory block pins are connected and standard cells pins are connected. 
 

5.5.3 Signal Routing 
For global and detailed routing, NanoRoute is used. The router does global and 
detailed routing, automatic search and repair, and optimisation.Select: 
 

Route -> NanoRoute 
 
Stick with the default values and hit OK (somewhat time-consuming). 

5.5.4 Saving the Routed Database 
The design database now contains final routing. Select: 
  

Design -> Save As… 
 
Enter design name top_routed 

5.5.5 Verify 
When the design is placed and routed, a number of design checks can be made. In 
addition, we can perform a timing analysis to get a timing report. 
For example, use the Verify Geometry form to verify the physical layout of the 
design, such as widths, spacing, and internal geometry of objects. 
Select: 
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 Verify-> Verify geometry… 
 
And hit OK. 
A violation is identified as an X-marker in the GUI. Too identify the marker; select 
the Q-button at the bottom of the Encounter window. Then move the mouse curse 
close to one of the X- markers. Another way is to select 
 
 Verify-> Violation Browser… 
 
To perform timing analysis, select 
 
 Timing-> Timing Analysis… 
 
Stick with the default values and hit OK. 
When finished, the console output should be something like: 
 
*** Dump slack report (0:00:00.0) 
**Info: no slack violation path. 
 
Slack File  : top.slk 
targetSlack : 0.000 ns 
--------------------  -------    ------- 
 Slack Range (ns)      Count        Sum 
--------------------  -------    ------- 
( 19.157 ~  19.000]        1          1 
--------------------  -------    ------- 
Total negative slacks(TNS)=0 
Worst negative slacks(WNS)=19.157 
 
which indicates that the timing is similar as reported when dosing front-end synthesis. 
 
 


